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CHAPTER ONE
Getting Started
Before you begin to use the Jury Management System, it is important to become familiar with its
functions and to understand the terminology and standards used in this manual. This chapter contains a
number of topics that will help you to better understand and use the Jury Management System.
Introduction to the Jury Management System
The Jury Management System (“Jury System”) provides a way for county governments to manage the jury
process. The Jury System is a comprehensive system offering a wide range of functionality and many
customizable features, all within an easy-to-use interface.
Many jury maintenance functions are automated, including the mass qualifying of panel jurors, entering
attendance, and mileage codes for multitude of jurors, and creating payment records to the CAI Financial
System. Jurors are assigned to jury panels that are in turn assigned to dockets, enabling you to easily
track a juror as he/she travels through the jury system.
In working with jurors, you can assign them to panels, update voir dire information, excuse, assign to
dockets, and issue payments for attendance and mileage to the CAI Financial System. You can also
generate numerous reports including (but not limited to) docket proof lists, jury master source lists, and
payment proof lists as well as a listing of unpaid jurors.
The Jury System consists of a Control Menu designed for system administration (or your county Jury
Commissioner) and a Main Menu designed for other users. The Control Menu is where system
administrators (or your county Jury Commissioner) merge voter records with driver license records to
create jury wheels and subsequently eligibility wheels. This is also where they set up and edit system
codes including juror exemption codes, jury payment codes, court locations, and judge records. The Main
Menu is where users work with jury wheels, panel jurors, and dockets.
To get the most of the Jury Management System, understand that all jurors are listed in the Master
Source List. This is the main list of all prospective jurors. From this list panels are created where jurors
are qualified. Once jurors are qualified, you will place them on a docket for upcoming jury trials.
As part of this process, work in retrospective motion to move from one year to the next. Close dockets in
order to close panels. At this time jurors that did not serve may be moved to the following year panel for
selection to a docket.
Keyboard Short Cuts
The keyboard shortcuts in this section are standard throughout the Jury System and can be used to
quickly perform several common functions.
Key
F1
F3
F4
F5
F6

Function
Help
Escape
Search or Prompt
Refresh
Add

Key
F7
F8
ESC
TAB

Function
Change
Display
Close window
Move to next field
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Jury Main Menu Toolbar Buttons
The Main Menu consists of the Master Source List, Panel Control, Docket Control, and System reports.
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CHAPTER TWO
Master Source List
Listing and Displaying Master Source List
To display a list of jury wheels, click the Jury Wheel toolbar button from the Jury Main Menu. This will
display the List Jury Wheel window showing and alphabetical list of jurors included in the current year’s
jury wheel. From this screen you can perform such functions as displaying and changing juror records,
completing voir dire information, and assigning jurors to panels and dockets.
(Insert image)
To work with the jury wheel for a different year, click the Select Different Year button to display the List
Jury Wheel control window. From this window, highlight the desired year and then click the Select button
or just double click on the year. The List Jury Wheel window will redisplay showing jurors included in the
jury wheel for the newly selected year.

Displaying Juror Information
1. From the List Jury Wheel window, highlight the desired juror record and click the
Display
toolbar button, press F8 on your keyboard, or select the Display option from the Process menu.
The Display Jury Wheel window will appear showing information for the selected juror.
2. Click the Street or Mailing button to select the address type that you desire to display. To display
or change other juror information, click one of the buttons at the bottom of this window as
described in the following section:
a. Click the Voir Dire button to display or change voir dire data for this juror. Refer to the
section on Adding Juror Voir Dire Information on page 21 of this manual for instructions
on working with voir dire information.
b. Click the Notes button to display notes for the juror. See Working with Juror Notes on
page 23 of this manual for more information on working with juror notes.
c. Click the Excused button to display excused dates and information for tis juror, if any.
See Excusing a Juror on page 19 of this manual for further instructions on using juror
excused dates.
d. Click the Source button to display the original eligibility wheel source record information
from which this juror was created.
e. Click the Juror Panels button to display all jury panels to which this juror has been
assigned.
f. Click the Juror Dockets button to display all dockets to which this juror has been assigned.
Refer to Listing Dockets for a Juror on page 25 of this manual for more information on
using the List Juror Dockets window.
3. After reviewing desired juror information, click the Done button to close the Display Jury Wheel
window and return to the List Jury Wheel window.
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Searching for Jurors on the Jury Wheel
1. From the List Jury Wheel window, click the Search button, press F4 on your keyboard or select
the Search option from the View menu. The Search Jury Wheel window will be displayed.
2. To position the list of juror names, enter the first few letters of the last name of the desired juror
in the Last Name field. To find a specific juror or group of jurors, enter the desired search
information on the Equals section as outlined in the following section.
Wheel Seq #
Driver’s License
Soc Sec #
Status
Exemption…

The system-assigned sequence number of the juror you wish to find.
The driver’s license number of the juror you want to find.
The social security number of the juror you want to find.
The status of the juror or jurors you wish to find. To view and select from a list of statuses,
click the down arrow to the right of the field.
The exemption code of the juror or jurors you want to find. From this field, press F4 on your
keyboard and choose from a list of exemption codes.

3. Click the OK button or press Enter on your keyboard to process the search and return to the List
Jury Wheel window. If you entered text in any of the fields shown under the Position To portion
of the screen, the list of juror’s names will be positioned to the first name matching the data
entered. If you entered data in fields shown under the Equals portion of the search window, the
list will only contain juror records matching the search criteria entered.
4. Click the Refresh button, press F5 on your keyboard, or select the Refresh option from the view
menu to restore the juror list to show all records for the selected year.
Changing Juror Information
1. From the Jury Main Menu, click the Jury Wheel toolbar button or select the Jury Wheel option
from the Select menu. The List Jury Wheel window will display.
2. Select the juror record to be changed by clicking on the desired row.
3. Click the Change button, press F7 on your keyboard, or select the Change option from the
Process menu. You can also right click on the row and select the Change option from the drop
down menu or just double-click on the row. The Change Jury wheel window will be displayed
showing information for the selected juror in all completed fields.
4. Change information for the juror as necessary. Descriptions for each data field are as follows:
Last Name
First Name
Middle Name

The last name of the juror. Include hyphenated last names if applicable.
The first name of the juror.
The middle name or initial of the juror.

Suffix
Driver’s license
Address1/Address2

The suffix for the juror’s name (i.e. Jr., III, etc.) if applicable.
The driver’s license number of the juror.
The first and second lines of the street and mailing addresses. Note – The field
label will appear in blue if the street address if being displayed or in red if the
mailing address is displayed.
The city, state, and zip code for the street and mailing addresses. The state should
be entered using a two-character postal abbreviation. Note – Street address
displays in blue; mailing address displays in red.
The social security number of the juror.
The birth date of the juror in mm/dd/yyyy format.

City/State/Zip

Soc Sec #
Birth Date
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Home Phone
Work Phone
Extension
Cell Phone
Distance
Date Qual Sent

Postponed
Exemption…

E-Mail
Assigned to Panel?
Voir Dire?

The home telephone number of the juror.
The work/office telephone number of the juror.
The work/office telephone extension of the juror, if applicable.
The juror’s cell number, if applicable.
The distance (one way) in miles from the juror’s home to the courthouse.
The date that jury qualification notice was sent to the juror. This date
automatically defaults to the Panel Control Date Mailed, but can be changed as
needed for an individual juror.
The date on which the juror’s postponement will be complete and the juror will
again be available for jury duty.
When an exemption code is selected, the description of the exemption code
automatically appears to the right. From this field, press F4 on your keyboard and
choose from a list of exemption codes.
Juror’s e-mail address, if applicable.
This box will be checked if the juror has been assigned to a panel
This box will be checked if the juror’s voir dire responses have been entered into
the system.

5. If you wish to display or change additional juror information, use the buttons at the bottom of the
window to do any of the following:
i. Click the Voir Dire button to display or change voir dire data for this juror. Refer
to the section on Adding Juror Voir Dire Information on page 21 of this manual
for instructions on working with voir dire information.
ii. Click the Notes button to display notes for this juror. See Working with Juror
Notes on page 23 of this manual for more information on working with juror
notes.
iii. Click the Excused button to display excused dates and information for this juror,
if any. See Excusing a Juror on page 19 of this manual for more information on
using juror excused dates.
iv. Click the Source button to display the original eligibility wheel source record
information from which this juror records was created.
v. Click the Juror Panels button to display all jury panels to which this juror has been
assigned. If the juror has not yet been assigned to a panel, this button will
appear grayed out. The “A” button can be used to activate a juror to a panel and
will appear grayed out if a juror is already active on a panel.
vi. Click the Juror Dockets button to display all dockets to which this juror has been
assigned. Refer to Listing Dockets for a Juror on page 25 of this manual for more
information on using the List Juror Dockets window. If the juror has not yet been
assigned to a docket, this button will appear grayed out. The “A” button can be
used to activate a juror to a docket and will appear grayed out if a juror is already
active on a docket.
6. After displaying or changing any desired juror information, click the Change button to save the
juror record and close this window. You will be returned to the List Jury Wheel window.
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Excusing a Juror
The instruction outlined in this section describe how to excuse a juror from the Change Jury Wheel
window used to change juror information.
1. From the Jury Main Menu, click the Jury Wheel toolbar button or select the Jury Wheel option
from the Select menu. The List Jury Wheel window will be displayed.
2. Select the juror record to be excused by highlighting on the desired row.
3. Click the Change button, press F7 on your keyboard, or select the Change option from the
Process menu. You can also right click on the desired row and select the Change option from the
drop down menu or just double-click on the desired row. The Change Jury Wheel window will be
displayed showing information for the selected juror in all completed fields.
4. Click the Excused button at the bottom of the window. The List Juror Excused Dates window will
be displayed.
5. Highlight the desired excused date listed within the grid on this screen and click the Done button.
If the desired date is not listed within the grid, or if you desire to change or delete an existing
excused date, utilize the buttons located on the lower toolbar of this screen to complete the task.
Adding an Excused Date
From the List Juror Excused Dates window, highlight the date within the grid that you desire to change
and click the Change Excused Date or press F7 on your keyboard. The Change Juror Excused Dates
window will display showing information pertaining to the just previously highlighted excused date in all
completed fields. Made desired changed in the From, To and/or Description fields and click the Change
button to effect the change(s) and return to the List Juror Excused Dates window.
Deleting an Excused Date
From the List Juror Excused Dates window, highlight the date within the grid that you desire to delete and
click the Delete Excused Date button located on the lower toolbar. A window will display asking you to
confirm the deletion. Click Yes to delete the date or No to abort the deletion and return to the List Juror
Excused Dates window. Note that if you clicked “Yes”, the date will not now appear within the grid on the
List Juror Excused Dates window.
Adding Juror Voir Dire Information
This section describes the process of entering voir dire information for a juror selected from the jury
wheel. Please note that the Add Juror Voir Dire window can also be displayed from other windows
throughout the Jury Management System.
1. From the Jury Main Menu, click the Master Source List button to display the List Master Source
List window showing all jurors in the current Master Source List.
2. Select the juror for which you want to enter voir dire information by clicking on the desired row.
3. Click the Voir Dire button or select the Voir Dire option from the Process menu. You can also
right click on the row and select this option from the drop down menu. Note that you cannot
assign a Voir Dire if the juror’s status is eligible. The Add Juror Voir Dire window will be displayed.
4. Complete the initial voir dire information for the juror. Descriptions of each data field are
outlined here:
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Gender
Years of
Education
Age
Years of
Residency
Marital Status
Prior Residence
Spouse’s Name
Number of
Children
Ages of
Children
Juror
Occupation
Employer
Business Phone
Retired Status?
Spouse
Occupation
Spouse
Employer
Spouse Bus.
Phone
Spouse Retired?

The gender of the juror. To select a gender, click the down arrow to the right of the
field.
The number of years of education completed by the juror. This should include years
of grade school and high school completed.
The age of the juror. This field is automatically calculated by the system based on the
birth date of the juror.
The total number of years the juror has maintained residence in the state of Idaho.
The marital status of the juror. To view and select from a list of valid codes, click the
down arrow to the right of this field.
The city and state in which the juror lived prior to his/her current residence. Leave
these fields blank if the juror has had no prior residences.
The name of the juror’s spouse, if applicable.
The number of children the juror has, if any.
The ages of the juror’s children, if applicable. The age of each child should be
separated by a comma and a space (i.e., “5, 8, 12”).
The occupation or profession of the juror.
The name of the juror’s employer. Leave this field blank if not applicable.
The business or work telephone number of the juror, if applicable.
Click this check box if the juror is retired.
The occupation or profession of the juror’s spouse, if applicable.
The name of the employer of the juror’s spouse, if applicable.
The business or work telephone number of the juror’s spouse, if applicable.
Click this check box if the juror’s spouse is retired.

5. After entering the initial voir dire information, click the Next Page button to continue entering
voir dire information. If you do not wish to enter additional voir dire information, you can click
the Add/Change button to save the information and close this window.
6. On the second Add Juror Voir Dire window, responds to the questions listed by clicking the
appropriate radio buttons to indicate a Yes, a No, or a No Response and entering additional
information as necessary.
7. After responding to all questions, click the Add button to save the information entered and return
to the Master Source List window.
Working with Juror Notes
The juror notes function of the Jury Management System records actions involving each individual juror
such as being selected for a panel or a docket. This function also allows you to enter any additional notes
pertaining to a juror. Please note that, while the instructions listed in this section describe how to work
with notes for a juror selected from the Master Source List, the Juror Notes window can be displayed
from other windows throughout the Jury Management System.
1. From the Jury Main Menu, click the Master Source List button to display the List Master Source
List window showing all current prospective jurors.
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2. Select the juror for which you want to view or enter notes by clicking on the desired row.
3. Click the Notes button or select the Notes option from the Process menu. You can also right click
on the row and select the Notes option from the drop down menu. The Juror Notes window will
be displayed showing existing notes for the selected juror, if any.
4. To enter an additional comment for the juror, click on the next available date field and enter the
applicable date. Then use the right arrow key, or the tab button on your keyboard to the Text
column ad enter the desired comment. After reviewing and entering all applicable comments,
click the done button to save the information and return to the List Master Source List window.
Listing Panels for a Juror
1. From the Jury Main Menu, click the Jury Master Source List to display the List Master Source List
window showing all prospective jurors in the current list.
2. Select the juror for which you want to list juror panels by clicking on the desired row. Note that
the juror’s status must show “Panel” in the status column on the Master Source List window.
3. Click the Juror Panels button or select the View Jurors Panels option from the Process menu. You
can also right lick on the row and select this option from the drop down menu. The Master
Source List window will be displayed showing all panels to which the selected juror has been
assigned.
4. If you want to display dockets to which the juror has been assigned, click the Dockets button to
display the List Juror Dockets window (instructions for using this window are in the next section).
5. Click the Done button when finished, to close this window and return to the Master Source List.
Listing Dockets for a Juror
1. From the Jury Main Menu, click the Master Source button to display the Master source List
window showing all prospective jurors in the current list.
2. Select the juror for which you want to display jury dockets by clicking on the desired row. Note
that the juror must be assigned to a panel before this selection can take place.
3. Click the Juror Dockets button or select the View Jurors Dockets option from the Process menu.
You can also right click on the row and select this option from the drop down menu. The List
Juror Docket window will be displayed.
4. To display or change additional juror information from this window, se the buttons on the right
side of this window to do any of the following:
 Click the Juror Info button or press F7 on your keyboard to display or change
basic juror information. Refer to the section on Changing Juror Information on
page 16 for further instructions.
 Click the Voir Dire button or press F8 on your keyboard to display or change voir
dire data for this juror. Refer to this section on Adding Juror Voir Dire
Information on page 21 for instruction on working with voir dire information.
 Click the Notes button or press F9 on your keyboard to display notes for this
juror. See Working with Juror Notes on page 23 for more information on working
with juror notes.
5. Click the Done button when finished, to close this window and return to the Master Source List
window.
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Entering Attendance for a Docket Juror
1. From the List Juror Docket window, highlight the docket within the grid that you desire to add
attendance to and click the Attendance button. The Change Docket Jurors window will display.
2. Enter attendance information for the juror as outlined here:
Full Days
Half Days
Status
Distance
from home

The total number of days served by the juror.
The total number of half days served by the juror.
The docket status of the juror. To change the status, click on the arrow to the right of this
field and select the desired code. This field will not normally need to be changed manually.
The distance (one way) in miles from the juror’s home to the courthouse or other jury service
location. This will default to the distance entered in the juror’s voir dire information but can
be changed here, if necessary.

3. Click the Change button to save the juror attendance information and close this window. You
will be returned to the List Juror Dockets window.
Entering Mileage and Service for a Docket Juror
You can create mileage and service payment records for a juror from the List Dockets window using the
process described in this section. Please note that attendance and mileage information must be entered
for the juror before payment records can be created.
1. From the List Juror Dockets window, enter the payment code to be used for mileage payments
for this juror in the Mileage… field. To view and select from a list of valid codes, double-click this
field to display a list to select from. Note: Be sure to select “mileage” payment code to ensure
that payment is made to the proper financial fund.
2. In the Service… field, enter the payment code to be used for jury service payments for this juror.
To view and select from a list of valid codes, double-click this field to display a list to select from.
Note: Be sure to select “service” payment code to ensure that payment is made to the proper
financial fund.
3. From the displayed list of dockets, highlight the docket for which the juror is to be paid and click
the Payments button or press F11 on your keyboard.
4. Now click the Pay Juror button to create the payment record for this juror. To view payments
already entered from the juror, click the Payments button or press F11 on your keyboard. The
List Juror Payments window will display showing a listing of all payments made to the selected
juror.
Printing Qualification Notices for Master Source
The processes described in this section outline instructions for printing qualification notices for jurors on
a Master Source List. This process should only be used by two-step counties. If your county uses the onestep process, qualification notices will be printed for juror already assigned to a panel. Refer to the
section on Printing Qualification Notices for Panel Jurors beginning on page 39 for more information.

Mass Qualifying Jurors…
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The Mass Qualify Jurors function described here provides a way to quickly qualify a number of jurors
without changing each individual record.
1. From the Jury Main Menu, click the Jury Panel Control button to display the List Panel window
showing all prospective jurors in the current panel.
2. Select a juror to be qualified for this list by clicking on the desired row. To select multiple jurors,
press and hold the CTRL key on your keyboard and click on any additional juror names. Use the
vertical scroll bar to page up and down through the list of jurors.
3. Click the Qualify Jurors button. A message will be displayed asking if you wish to continue with
this process. Click the OK button to continue or click No or Cancel to cancel this process without
qualifying the selected jurors. You will be returned to the List Panel Jurors panel.

CHAPTER THREE
Jury Panel Control
The Jury Panel Control window displays the names of jurors who have been selected and assigned to a
jury panel.
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To display a list of jurors assigned to jury panels, click the Jury Panel Control button or select the Jury
Panel control option from the Select menu on the Jury Main Menu.
If you want to display panel jurors for a different Maser Source Control, click the Select Different Year
button to display the List Master Source Control Year window. Click the desired year and then click the
Select button or double-click on the desired year.
Searching for Active Panel Jurors
1. From the List Panel Control window, click the Search button, press F4, or select the Search option
from the view menu. The Search Panel Jurors window will be displayed.
2. To position the list of juror names, enter the first few letters of the last name of the desired juror
in the Last Name field. To find a specific juror or group of jurors, enter the desired search
information in the Equals section as outlined here:
Wheel
Seq#
Panel #
Reporting
#
Status

The system-assigned sequence number of the juror you wish to find.
The system-assigned panel number of the juror or jurors you want to find.
The system-assigned jury reporting number of the juror you want to find.
The status of the juror or jurors you wish to find. To view and select from a list of statuses, click
the down arrow to the right of this field.

3. Click he OK button or press the Enter key to process the search and return to the Active Panel
Jurors window. If you entered text in the Last Name field, the list of juror names will be
positioned to the first name matching the search criteria. If you entered data in fields in the
Equals section of the search window, the list will only contain juror records matching the search
data entered.
4. Click the Refresh button, or press F5, or select the Refresh option from the View menu to restore
the juror list showing all records.
Changing Active Panel Juror Information
1. From the Active Panel Jurors window, select the juror records you wish to change by clicking on
the appropriate row.
2. Check the Change Juror Information button, press F7, or select the Change Juror Information
option from the Process menu. You can also right click on the row and select the Change Juror
Information option from the drop down menu. The Change Jury Wheel window will be displayed
showing information for the selected juror in all completed fields.
3. Refer to the section on Changing Juror Information beginning on page 16 for instructions on
updating juror records. Click on the Change button to save any modifications made and return to
the Active Panel Jurors window.
Working with Active Panel Juror Voir Dire Information

1. From the Active Panel Jurors window, select the juror records for which you want to enter voir
dire information by clicking on the appropriate row.
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2. Click the Voir Dire button or select the Voir Dire option from the drop down menu. The
Add/Change Juror Voir Dire window will be displayed for the selected juror.
3. Refer to the section on Adding Juror Voir Dire Information beginning on page 21 for instructions
on entering juror voir dire data. After entering and saving voir dire information, you will be
returned to the Active Panel Jurors window.
Working with Active Panel Juror Notes
From the Active Panel Jurors window, select the juror records for which you want to work with juror
notes by clicking on the desired row.
Click the Juror Notes button or select the Notes option from the Process menu. You can also right click on
the row and select this option from the drop down menu. The Juror Notes window will be displayed for
the selected juror.
Refer to the section on Working with Juror Notes beginning on page 23 for instructions on using the Juror
Notes window. After closing this window, you will be returned to the Active Panel Jurors window.
Listing Dockets for an Active Juror
From the Active Panel Jurors window, select the juror record for which you want to list dockets by clicking
on the desired row.
Click the Juror Dockets button or select the Display Juror Dockets option from the Process menu. You can
also right click on the row and select this option from the drop down menu. The List Juror Dockets
window will be displayed for the selected juror.
Refer to the section on Listing Dockets for a Juror beginning on page 25 for instructions on using the List
Docket Jurors window. After closing this window, you will be returned to the Active Panel Jurors window.
Listing Panels for an Active Panel Juror
From the Active Panel Jurors window, select the juror record for which you want to list panels by clicking
on the desired row.
Click the Display Juror Panels button or select the Display Juror Panels option from the Process menu.
You can also right click on the row and select this option from the drop down menu. The List Juror Panels
window will be displayed for the selected juror.
Refer to the section on Listing Panels for a Juror beginning on page 24 for instructions on using the List
Panel Jurors window. After closing this window, you will be returned to the Active Panel Jurors window.

Listing Jurors on a Panel
This function allows you to select a juror assigned to a particular panel and display a list of jurors assigned
to the same panel.
From the Active Panel Jurors window, select the desired juror record by clicking on the appropriate row.
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Click the Display All Panel Jurors or select the Display Panel Jurors option from the Process menu. You
can also right click on the row and select this option from the drop down menu. The List Panel Jurors
window will be displayed for the selected juror.
Refer to the section on Working with Jurors on a Panel beginning on page 36 for instructions on using the
List Panel Jurors window. After closing this window, you will be returned to the Active Panel Jurors
window.

CHAPTER FOUR
Jury Panels
Listing Jury Panel Control Files
To display a list of jury panels, click the Jury Panel Control toolbar button or select the Jury Panel Control
option from the Select menu on the Jury Main Menu. The List Panel Control window will display.
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From this screen you can perform such functions as viewing a list of jurors for a particular panel, add
jurors to a panel, and create a docket for a panel.
Changing a Panel Control File
1. From the List Panel Control window, select the jury panel to be changed by clicking on the
desired row.
2. Click the Change button, press F7, or select the Change option from the Process menu. You can
also right click on the row and select the Change option from the drop down menu or just double
click on the row. The Change Panel Control window will be displayed.
3. Make changes to the service and other dates as necessary. Refer to Assigning Jurors to a Panel
beginning on page 78 for descriptions of each of the date fields.
4. Click the Change button to save any modifications made to the panel control or click the Cancel
button to close this window without saving. You will be returned to the List Panel control
window.
Working with Jurors on a Panel
1. From the Jury Main Menu, click the Jury Panel Control toolbar button or select the Jury Panel
Control option from the Select menu. The List Panel Control window will be displayed.
2. Select the jury panel for which you want to list jurors by clicking on the desired row.
3. Click the List Jurors on a Panel button or select the List Jurors on a Panel option from the Process
menu. You can also right click on the row and select this option from the drop down menu. The
List Panel Jurors window will be displayed showing all jurors assigned to the selected panel. To
select the sort order of the listed jurors, click wither the Reporting # or Name radio button.
To display or change additional details on a particular row, click on the row listing the desired
juror and do one of the following:
 Click the Juror Info button or press F7 to display or change specific information
for the selected juror. See Changing Juror Information beginning on page 16 for
additional instructions.
 Click the Voir Dire button or press F8 to display or change voir dire data for the
selected juror. Refer to the section on Adding Juror Voir Dire Information on
page 21 for instruction on working with voir dire information.
 Click the Notes button or press F9 to display notes for the selected juror. See
Working with Juror Notes on page 23 for more information on working with juror
notes.
 Click the Excuse button to display excused dates and information for the selected
juror, if any. See Excusing a Juror on page 19 for instructions on using juror
excused dates.
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 Click the Dockets button to display all dockets to which the selected juror has
been assigned. Refer to Listing Dockets for a Juror on page 25 for more
information on using the List Juror Dockets window.
4. Click the Done button or press ESC on your keyboard to close this window and return to the List
Panel Control.
Searching for a Panel Juror
1. From the List Panel Jurors window, click the Search button or press F4. The Search Panel Jurors
window will be displayed.
2. Enter the desired search information as outlined below:
Sort By
Reporting #
Last Name
First, Middle,
etc.
Status

Click on one of the radio buttons to select the order in which the search results will be
displayed.
Enter the reporting number of the juror you wish to find. NOTE: This field will only be
displayed if Reporting # is selected as the sort order.
Enter all or part of the last name of the juror or jurors you want to find.
Enter all or part of the first of middle names or the name suffix (i.e., “JR”, “III”, etc.) of the
juror or jurors you want to find.
Select the jury panel status for jurors you wish to find. To view and select from a list of
statuses, click the down arrow to the right of this field.

3. Click the OK button or press Enter on your keyboard to process the search. The List Panel Jurors
window will be redisplayed showing only jurors matching the search information entered.
Printing Qualification Notices for Panel Jurors
The process described below outlines instructions for printing qualification notices for panel of jurors.
1. From the List Panel Jurors window, click the Print Qualification button. The Select Report window
will be displayed. Note: The Select Report window can also be displayed by clicking the Print
button or selecting the Print option from the View menu on the List Panel Control window.
2. From the Select Report window, locate and click on the report titled QUALIFICATION FORMS
PANEL and select your report destination options. Click the OK button to continue. The default
filter window for the report will be displayed.
3. Click the Select a Panel button to display the List Panel Control window and select the desired
panel by double clicking on the desired row. You will be returned to the default filter window
which will now display the selected panel number.
4. If you only want to print qualification notices for a select number of jurors, enter the desired
range of reporting numbers in the From and To Reporting # fields. Indicate whether you wish to
print notices for all jurors, no response or only postponed jurors by clicking on the appropriate
radio button. Finally, click the appropriate check boxes pertaining to the 2nd page of the
questionnaire form, the donation of jury fees and whether you want to exclude the question
concerning jury service during the past 24 months from the notices. If you decide to include the
question pertaining to jury fee donation, include in the donation field where the fees will be
donated to.
5. Click the OK button to complete the printing of qualification notices.
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Mass Qualifying Panel Jurors
The process of mass qualifying jurors for a panel is used to qualify several jurors at once.
1. From the List Panel Jurors window, click on the name of the first juror to be qualified. You can
select multiple jurors to be qualified by pressing and holding the CTRL key and clicking additional
names. Use the scroll bar to page up or down to locate the names of the jurors.
2. After selecting all jurors to be qualified, click the Qualify Jurors button or right click on one of the
highlighted rows and select the Qualify Jurors option from the drop down menu. The status of all
selected jurors will be changed to Qualified. Note: If a juror has already been assigned to a
docket, they cannot re-qualify.
Adding Jurors to a Panel
1. From the Jury Main Menu, click the Jury Panel Control toolbar or select the Jury Panel Control
option from the Select menu. The List Panel Control window will be displayed.
2. Select the jury panel to which you want to add jurors by clicking on the desired row.
3. Click the Add to Panel button or select the Add to panel option from the Process menu. You can
also right click on the row and select this option from the drop down menu. The Adding Jurors to
a Panel window will be displayed.
4. Enter the desired number of jurors you wish to add to this panel. Note: The number entered
cannot be greater than that shown in the Available Jurors field.
5. Click the OK button or press Enter on your keyboard to add the selected number of jurors to the
panel. When the process is finished, a message will be displayed telling you that the jurors were
successfully added. Click the OK button to close the message window and return to the List Panel
Control window.
Create a Docket for a Panel
1. From the Jury Main Menu, click the Jury Panel Control toolbar or select the Jury Panel Control
option from the Select menu. The List Panel Control window will be displayed.
2. Select the jury panel from which you want to create a docket by clicking on the desired row.
3. Click the Create Docket for a Panel button on the toolbar or select the Create Docket for a Panel
option from the Process menu. You can also right click on the row and select this option from the
drop down menu. The Add Docket Control window will be displayed.
4. Enter all applicable information for the new docket. Description for each data field are as follows:
Docket Type
Date Pulled
Docket
Control Active

Date Closed

(required) Select wither District or Magistrate as the type for this docket. To select a type,
click on the down arrow to the right of this field.
Enter the date on which this docket was created or “pulled”. This field defaults to the
current date, but can be changed if necessary.
When you close a docket, the system automatically checks off the active flag (making the
docket inactive). Processes you can perform with the docket, like adding jurors to a docket,
are limited when the docket is inactive. However, you can still enter attendance and
payments for an inactive docket.
Tis field is grayed out until you click the Close button. If there are any active jurors on the
docket, the system will not allow you to close the docket.
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Docket
Descriptions
Desired # of
Jurors
Reporting
Date
Reporting
Time
Court Room
Judge #...

Court
Location…

Enter up to four lines of description for this docket in these fields. These fields are used for
the printing of certain system reports involving dockets. Note: Line 1 of the description is a
required field.
(required) Enter the number of jurors you wish to include on this docket. This number
cannot exceed that shown in the Available Jurors field.
Enter the date on which jurors are to report for jury duty for this docket.
Enter the time of day at which jurors are to report for jury duty for this docket.
Enter the room number of the courtroom jurors are to report to.
(required) Enter the number of the judge in charge of this docket. To view and select from
a list of judges, position your cursor on this field and press F4, or just double click on the
field.
(required) Enter the identification code for the court location for this docket. To view and
select from a list of court locations, position your cursor on this field and press F4 or double
click on the field.

5. Click the Add button to save the information entered for the new docket. The docket will be
created and the number of jurors entered will be assigned to the docket. When this procedure is
complete, a message window will be displayed telling you that the jurors have been assigned.
Click the OK button or press ESC on your keyboard to close the message and return to the List
Panel Control window.
Listing Docket for a Panel
1. From the Jury Main Menu, click the Jury Panel Control toolbar button or select the Jury Panel
Control option from the Select menu. The List Panel Control window will be displayed.
2. Select the jury panel for which you want to list dockets by clicking on the desired row.
3. Click the List Dockets for a Panel button or select the List Dockets for a Panel option from the
Process menu. You can also right click on the desired panel and select this option from the drop
down menu. The List Docket Control window will be displayed.
NOTE: To display a list of jurors on a particular docket, click on the desired docket record and
then click the Docket Jurors button.
4. Click the Done button to close the List Docket control window and return to the List Panel Control
window.

Closing a Jury Panel
1. From the Jury Main Menu, click the Jury Panel Control toolbar button or select the Jury Panel
Control option from the Select menu. The List Panel Control window will be displayed.
2. Select the jury panel that you desire to close by clicking on the desired row,
3. Click the close Panel button or select the Close Panel option from the Process menu. You can
also right click on the desired panel and select this option from the drop down menu.
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CHAPTER FIVE
Working with Dockets
Listing Docket Control Files
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To display a list of docket control files, click the Jury Docket Control button or select the Jury Docket
Control option from the Select menu on the Jury Main Menu. The List Docket Control window will be
displayed showing all jury dockets for the current master source list year.
To display the jury wheel for a different year, click the Select Different Year button to display the List Jury
Wheel Control window. From this window, click on the desired year and then click the Select button or
just double click on the desired year.
Changing a Docket Control File
1. From the List Docket Control window, select the docket control file you wish to change by clicking
on the desired row.
2. Click the Change button, press F7, or select the Change option from the Process button. You can
also right click on the row and select the Change option from the drop down menu. The Change
Docket Control window will be displayed.
3. Change any necessary information for the docket. Descriptions for each field can be found under
Creating a Docket for a Panel on page 42 of this manual.
4. Click the Change button or press Enter on your keyboard to save any changes made to the docket
information. You will be returned to the List Docket Control window.
Deleting a Docket Control File
1. From the List Docket Control window, select the docket control field you wish to delete by
clicking on the desired row.
2. Click the Delete button or select the Delete option from the Process menu. You can also right
click on the row and select the Delete option from the drop down menu. The Delete Docket
Control window will be displayed with all data fields showing a red background.
3. Click the Delete button to complete the removal of the docket or click the Cancel button to close
tis window without deleting the docket. You will be returned to the List Docket Control window.
Note that the system will not allow you to delete a docket if jurors have been assigned to it.
Searching for a Docket Control File
1. From the List Docket Control window, click the Search button or press F4. The Search Docket
control window will be displayed.
2. Enter the desired search information as outlined below:
Docket
Descriptions
Judge
Court Location
Desc.
Reporting Date
Reporting Time
Date Pulled
Date Closed

Enter up to four lines of description for this docket in these fields. These fields are used
for the printing of certain system reports involving dockets. Not: Line 1 of the description
is a required field.
Enter the name of the judge assigned to the docket you are searching for.
Enter the description of the court location assigned to the docket you are searching for.
Enter the date on which jurors are to report for jury duty for this docket.
Enter the time of day which jurors are to report for jury duty for this docket.
Enter the date on which this docket was created or "pulled“. This field defaults to the
current date but can be changed if necessary.
This field is grayed out until the docket has actually been closed utilizing the Close button
on the Change Docket Control screen. If there are any active jurors on the docket, the
system will not allow you to close the docket.
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Docket Type
Docket Control
Active
Court Room
Judge #...

Court
Location…

Click the down arrow to the right of this field and choose District or Magistrate from the
drop down menu.
Click the down arrow to the right of this field and choose Yes or No from the drop down
menu.
Enter the room number of the courtroom assigned to the docket you are searching for.
Enter the number of the judge in charge of the docket you are searching for. To view and
select from a list of judges, position your cursor on this field and press F4 or just double
click the field.
Enter the identification code for the court location assigned to the docket you are
searching for. To view and select from a list of court locations, position your cursor on this
field and press F4 or just double click the field.

3. Click the OK button or press Enter on your keyboard to process the search. The List Docket
Control window will redisplay showing only dockets matching the search information entered.
Listing Jurors on a Docket
1. From the Jury Main Menu, click the Jury Docket Control button or select the Jury Docket control
option from the Select menu. The List Docket Control window will be displayed.
2. Select the docket control file for which you wish to list jurors by clicking on the desired row.
3. Click the List Jurors on a Docket button or select the List Jurors on a Docket option from the
Process menu. You can also right click on the row and select this option from the drop down
menu. The List Docket Jurors window will be displayed listing all jurors currently assigned to the
selected docket.
4. To display or change additional juror information from tis window, use the buttons on the lower
toolbar of this window to do any of the following:
Click the Juror Info button or press F7 to display or change specific information
for the selected juror. See Changing Juror Information beginning on page 16 for
additional instructions.
Click the Voir Dire button or press F8 to display or change voir dire data for the
selected juror. Refer to the section on Adding Juror Voir Dire Information on
page 21 for instruction on working with voir dire information.
Click the Notes button or press F9 to display notes for the selected juror. See
Working with Juror Notes on page 23 for more information on working with juror
notes.
Click the Attendance button or press F10 to add or change attendance for this
juror. See working with Juror Attendance on page 27 of this manual for more
information on working with juror attendance.
5. When finished, click the done button to close this window and return to the List Docket control
window.
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Juror Attendance
From the List Docket Control window, highlight the docket you desire to work with and click the List
Jurors on a Docket toolbar button or click Select on the menu bar and choose List Jurors on a Docket to
the drop down menu. The List Docket Jurors window will be displayed showing all jurors assigned to the
previously selected docket.
To display, add, change, or remove attendance for a juror, simply select the desired juror and click the
Attendance button or press F10. The Change Docket Jurors window will now display. Enter the number
of half days served, the number of full days served, the distance from home to the courthouse where
service tool place and change the juror status as necessary. When finished, click the change button to ad
changes and return to the List Docket Jurors window. Note that attendance can be changed and/or
deleted in the same way by merely changing the information fields (change) or resetting the field to “0”
(remove).
Adding Jurors to a Docket
1. From the Jury Main Menu, click the Jury Docket Control button or select the Jury Docket Control
option from the Select menu. The List Docket control window will be displayed.
2. Select the docket control field for which you wish to add jurors by clicking on the desired row.
3. Click the Add to Docket button or select the Add to Docket option from the Process menu. You
can also right click on the row and select this option from the drop down menu. The Adding
Jurors to a Docket window will be displayed. See page 49 of this manual for a description of fields
on this screen. When finished, press the OK button to add jurors to the selected docket and
return to the List Docket Control window.
Creating Payment Records to the CAI Financial System
To create payment records to the CAI Financial System, click the Jury Docket Control button or select the
Jury Docket Control option from the Select menu on the Jury Main Menu. The List Docket Control
window will be displayed showing all jury dockets for the current jury wheel year.
To work with the jury wheel for a different year, click the Select Different Year button to display the List
Jury Wheel control window. From this window, click on the desired year and then click the Select button
or just double click on the desired year.
Now click the Create Payment Records to the Financial Interface button, or select the Create Payment
Records to the Financial Interface option from the Process menu. You can also right click on the row and
select the Create Payment Records to the Financial Interface option from the drop down menu. A
warning screen will display stating that you are about to create payments to the financial interface. Click
Yes to continue, or No, or Cancel to abort the creation of payments and return to the List Docket Control
window.
Upon clicking Yes, the Process Juror Payments screen will display. Complete the Payment Date field and
click Process,
The List Docket Control window will again display stating that payments to the financial interface have
been completed.
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CHAPTER SIX
Printing Reports
A number of printed reports can be produced from the Jury System. You can print different reports from
nearly all of the main menus and list windows in the system. The reports available differ depending on
the menu or window you are viewing, but the process of selecting and printing is identical regardless of
which report you want.
Selecting Reports to Print
Most Jury System reports are printed using the Select Reports button on the toolbar. This button is
available from the toolbars on all of the main list windows. Printing reports from the Jury System typically
involves the following steps:
1. Click the Select Reports button on the toolbar to display the Report Selection window.
2. Select the report to be printed from those listed on the report Selection window. See Using the
Report Selection Window below for additional instructions.
3. Enter the desired report information on the default report filter. Refer to the section on Using
Report Filters beginning on page 56 for more information on report filters.
4. Click the OK button on the report filter and/or secondary filter to print the report.
Using the Report Selection Window
The Report Selection window is displayed when you click the Select Reports button from the toolbar or
select the Print option from the View menu. To select a report, click on the name of the report you wish
to print. If you don’t see the report you want, enter the first few letters of the report title in the Position
To field and move to that report.

After selecting the report you want to run, you need to select the destination and filtering options. Under
Report Destination, you will tell the system to send the report to either your screen or to a printer and
select the number of copies you want to print. You can also click the Setup button to change any
necessary settings on your printer.
For many reports, you can use the Filtering options to decide whether to use a filter to select only certain
records for the report or to include all records. Instruction on displaying filtering reports are outlined
below.
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Using Report Filters
Many of the reports in the Jury System use filters that allow you to select what types of records or date
ranges will be included on a report. The filters differ depending on which report you are printing.
Instructions on using report filters are provided below.
Using Default Report Filters
Default report filters are displayed when the Default radio button is selected on the Report Selection
window. These windows are relatively self-explanatory and include different data fields and buttons that
allow you to select the information that will be included on the selected report. Examples of default
report filters are shown below:

Many of the default report filters in the Jury System include buttons that allow you to select the desired
jury year, panel, and docket. Instructions for using these selection buttons can be found the sections
below.
Some default report filters use radio buttons that allow you to select the type of records to be included
on a report. To select a particular record type, click the radio button next to the desired type description.
Some filters also allow you to select a particular code for a report. Where a code is required, the field will
typically be a search field (denoted by three periods following the field name, such as “Exemption
Code…”). You can view and select from a list of valid codes for these fields by positioning your cursor on
the field and pressing F4, or by double clicking on the field.
After entering all desired information on a default report filter, click the OK button to continue printing
the report. The report will be printed or displayed on the screen, depending on the options entered on
the report filter. For more information on displaying a report on the screen, see page 59.
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Selecting a Different Master Source Year for Reports
1. From the default report filter, click the Select Different Year button. The List Jury Master Source
Control window will be displayed.

2. From the List Jury Master Source Control window, click on the desired control year and then click
the Select button or double click on the desired year. You will be returned to the report filter
which will now display the selected year.
Selecting a Jury Panel for Reports
1. From the default report filter, click the Select a Panel button. The List Panel Control window
will be displayed showing all active panels for the year selected on the report filter.
2. If you want to display all jury panels, including inactive panels, click the All Panels radio
button at the top of the window.

3. Click on the desired panel to be used on the report and then click the Select button or double
click on the desired panel. You will be returned to the report filter which will now display the
selected panel.
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Selecting a Jury Docket for Reports
1. From the default report filter, click the Select Docket Control button. The List Docket Control
window will be displayed showing all dockets for the year and panel selected on the report filter.

2. To display all dockets, including inactive dockets, click the All Dockets radio button at the top of
the window.
3. Click on the desired docket and then click the Select button or double click on the desired docket.
You will now be returned to the report filter which will now display the selected docket.
Displaying Reports on the Screen
When selecting a report, you have the option of printing a report to a print or to your screen under
Report Destination options. If you select the Window option, your report will “print” to the screen and
appear just as it would appear on paper. You can click the Close button at any time to exit the Report
Display window and return to the report selection.
Once the report is display on the report display window, you can page through the report, increase or
decrease the magnification (zoom), and print the report to paper or export it to another application.

Paging through a Displayed Report
To page through a report that you have displayed on the screen, you can use your keyboard page up and
page down keys, scroll bars on the screen, and the paging toolbar icons listed.
Go to first page of report.
Go to previous page of report.
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Go to next page of report.
Go to last page of report.
Changing the Display Magnification
You can change the magnification of a displayed report, or “zoom” in or out, to make the report easier to
read and review. To increase or decrease the magnification, click on the arrow to the right of the report
magnification field and select the desired value. You can select a value from 25% to 400% or enter a
specific magnification in the field and press the TAB key on your keyboard.
Printing a Displayed Report
To print a report after displaying it on the screen, click the Print button at the top of the Report Display
window. This will display the Print widow and allow you to select the pages you wish to print as well as
the number of copies. Click the OK button on this window to print the report.
Exporting Report Files
After displaying a report on the screen, you can export the report to a file for use in a spreadsheet, word
processing, or other software. To export a report:
1. Select and print a report to the screen as describes in previous section.
2. Click the Export button on the top of the Report Display window.
3. Select the desired format for the exported file. The most commonly used formats are EXCEL,
Word, and PDF. In the Destination field, select Disk file.

4. Click the OK button. If you selected EXCEL format, an additional Format Option window will be
displayed. The settings on this window are generally sufficient, but you may wish to include
column headings. Click OK to continue. The Choose Export File window will be displayed.
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5. On the Choose Export File window, select the drive and folder where you want to save the
exported file.
6. Enter the name of the exported file to be saved in the File name field. You can leave the name of
the report as displayed, but you may wish to enter a more descriptive name. The Save As Type
field will contain the type of file you selected in the earlier Export window. Do not change this
field.
7. Click the Save button to export the report and save it to the selected drive.
Printing a List of Available Reports
You can find out what reports are available in the Recording System by printing a list of all reports.
1. Click the Select Reports button in the main toolbar.
2. Click the report titled REPORTS LIST and select your report destination options.
3. Click the Print button to print the report.
Report Troubleshooting
You may occasionally run across trouble when printing reports. Printing problems can be caused by a
wide variety of factors. This section covers a number of the most common problems and their solutions.
If the suggestions outlined in this section don’t solve your problem or answer your question, contact the
Computer Arts, Inc. help desk at 800-365-9335.
I can’t find the report I need.
Sometimes it might be difficult to figure out where to go in the system to print the specific report you
want. Here are some things you can do when you run into this problem:

 Go to the window most closely related to the desired report. Consider major report topics such as
instruments, cash, liquor licenses, catering permits, and marriage licenses. After displaying the
window most closely related to the desired report, click the Print button on the window, if
available, or click the Print icon on the toolbar. This will display a list of report that can be run
from this section in the system.
 Consider whether you want a report for one record or for a list of records. For example, if you
want to print information for a single instrument, display the desired instrument and click the
Print button on the display window. You can also right click on a particular record from a list
window and select the Print Selected Row option from the menu. Reports involving multiple
records are printed by clicking on the Select Reports icon on the toolbar.
 Click on the Select Reports icon on the Recording Main Menu toolbar. From the Main Menu, click
the Select Reports icon to list all reports available from this location of the system, including
these that are not specifically related to a particular list or display window.
When I launch a report, I get an error message.
Computer Arts, Inc. makes every effort to prevent printing errors. However, you may occasionally
encounter error messages in the form of pop-up windows. Some messages are relatively simple while
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other can be lengthy and contain somewhat cryptic symbols or abbreviations. Here’s what you can do if
you run into this:
 Write down the message as completely as possible. Better yet, press ALT+Print Scrn on your
keyboard to copy the window, paste it into an email message or Notepad, and print a copy. If
you receive more than one error window, do this for each message. The exact wording of the
messages is important in troubleshooting the exact cause.
 Try to recall your steps before receiving the error. In order to find the cause of the problem, it is
important to be able to duplicate it, if possible. This will assist Computer Arts personnel in their
troubleshooting. If necessary, try to write down the names of the windows displayed and options
selected before you received the error message(s).
 Contact Computer Arts help desk 800-365-9335. The help desk technicians can help resolve the
problem or refer you to another CAI employee to help you. It is important that you have the text
of the error messages in front of you when you call.
When I launch a report, nothing comes out of the printer or nothing happens at all.
The causes of problems like this range from slow printing performance to incorrect printer installation.
Here’s what to look for:
 Consider the size and length of the report. Every effort is made by CAI to optimize report
processing and performance. However, many reports have to process a great deal of information
and may take some time to print or display on your screen. If reports are taking a very long time
to print, contact your CAI help desk at 800-365-9335.
 Check the status of the printer. Problems of this type can result from a printer being offline or
disconnected from the server. Sometimes, error messages will be displayed on the printer itself.
Check to make sure the printer is online and, if any errors are displayed, look them up in your
printer documentation or help text to determine the cause.
 Check our printer installation. This kind of problems can also be caused by an incorrect
installation of a printer driver on your PC. To check this, click on your Windows Start icon, select
Control Panel, Devices and Printers. This will display all of the printers installed on your PC. Right
click on the icon for your printer you sent your report to and select the Properties options. Click
the Print Test Page button and check the printer to make sure the page printed correctly. If so,
the problem is not with your printer installation or connection.
 Contact Computer Arts Help Desk 800-365-9335. The help desk technicians can help resolve the
problem or refer you to another CAI employee to help you.

When I print a report, some fields are cut off along the margins.
Reports designed with Crystal Reports tool used in the Recording System may print differently based on
various printers and printer drivers used. While every effort is made to reduce these differences, you
may encounter a report where certain fields or even the entire reports seems to be cut off along one or
more of the margins. If you encounter this problem, contact the Computer Arts Help Desk at 800-365-

Jury Management System
9335 for assistance in checking the compatibility of your printer or determining whether the reports
needs to be reformatted.
I exported a report to Excel or Word file, but the person I sent the file to can’t open it.
This problem generally occurs when the PC being used to open the file does not have MS Excel or Word
installed. If this the case, the software will need to be installed on the PC. Alternatively, another PC that
has the software installed can be used to open the file.
When I export a report to Excel or Word, I lose some of the report formatting.
Because of the many different methods used by software programs to format documents and
spreadsheets, it is common to lose some design and formatting features when exporting reports to other
software. Some of the most common formatting feature lost during export include shading, lines, boxes,
and page headers.
The best way to avoid loss of formatting in exported documents is to ensure that the format used to
export the file is compatible with that used by the software that will open the file. When exporting MS
Excel files, use the EXCEL 5.0 (XLS) or EXCEL 5.0 (XLS) (EXTENDED) format options. It may also be helpful
to experiment with different formats to find those that best preserve your report formatting.
Location of System Reports
It may occasionally be difficult to find where in the program to generate a specific report, or to determine
what distinguished one report from another. To help you make sense of the Jury Management System
reports, here is a summary of some of the report title and brief descriptions of what they include. Also
included are the names of the windows where the reports are found and the toolbar buttons used to
print them.

CHAPTER SEVEN
Jury Control Menu
The Jury Control Menu contains a number of tools for setting up information used throughout the Jury
System.
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To display the Jury Control Menu, double click on the appropriate icon on your desktop or open the
program through the Windows Start Menu. A valid user name and password will be require for access to
the Control Menu.
CAUTION !!!
Because certain parts of the Control Menu contain settings and codes which affect the entire Jury System,
changes must only be made by someone who is thoroughly familiar with the system and qualified to
make these modifications. Changes made from the Control Menu can dramatically affect the operation
of the Jury System or prevent it from working entirely. If you have any questions or doubts about making
changes, contact Computer Arts, Inc. prior to doing so.
Working with the Voter Master Files
To display a list of registered voters, click the Voter Mater File toolbar button from the Jury Control
Menu. This will display the List Voter Master File window showing an alphabetical list of all registered
voters who have been merged into the Jury System. From this window you can display information for
any of the voter records and merge those voter records into the Jury System.
Display Registered Voters
1. From the Jury Control Menu, click the Voter Master File button to display the List Voter Master
File window.
2. Select the voter record you wish to display by clicking on the desired row. To locate a particular
voter, refer to Searching for Voter Records below.
3. Click the Display button, press F8, or select the Display option from the Process menu. You can
also right click on the row and select the Display option from the pop-up menu or double click on
the row. The Display Voter Master File window will appear showing information for the selected
voter in all completed fields.
4. To display the mailing address for the voter, click the Mailing button. Click the Street button to
redisplay the street address.
5. Click the Done button to close this window and return to the List Voter File window.
Searching for Voter Records
1. From the Jury Control Menu, click the Voter Mater File button to display the List Voter Master
File window.
2. Click the Search button, press F4, or select the Search option from the View menu. The Search
Voter Master File window will be displayed.
3. To position the list of voter names to a particular last name, enter the first few letters of the
name in the Full Name field. Make sure that the other search fields on this window have been
cleared.
To search for a specific voter or group of voters, enter the desired search information as described below.
Last name

All or part of the last name of the voter or voters you want to find.

First Name

All or part of the first name of the voter or voters you want to find.
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Middle

All or part of the middle name of the voter or voters you want to find.

Suffix

The suffix listed in the records of the voter you wish to find.

Driver’s
License
Soc Sec #

The driver’s license number of the voter you wish to find.

Home Phone

The home telephone number of the voter you wish to find.

Deceased

Click the down arrow to the right of this field and select the Yes option to search only voters
listed as deceased in the voter master file.

The social security number of the voter you wish to find.

4. Click the OK button or press Enter on your keyboard to process the search. If you entered data
only in the Full Name field, the List Voter Master File window will be displayed with the name of
the voter matching the search data entered at the top of the list. If you entered information in
any of the other search fields, the List Voter Master File window will be redisplayed showing only
voters matching the search information entered.
5. Click the Refresh button or press the F5 key to restore the List Voter Master File window to show
all voters in the file.
Importing Voters from the Voter System
The process for creating the Master Source Wheel in the Jury System involves the importing and merging
of records from the voter master file and driver’s license file from the Department of Transportation. This
process is outlined in the section on Building Master Source Wheel beginning on page_____. It is highly
recommended to import these files together.
Before the voter file can be imported into the Jury System, it must be exported from the Voter System to
the file called VOTER.txt on your local C:\.
Important: When importing records from the Voter System, all voter records in the Jury System will be
overwritten with the current voter records. Running this process will remove all voter records in the Jury
System and replace them with current voter records.
Working with Driver’s License Files
To display a list of licensed drivers, click the Driver’s License Master File toolbar button from the Jury
Control Menu. This will display the List Driver’s License Master File window showing an alphabetical list
of all licensed driver who have been merged into the Jury System. From this window you can display
information for any of the voter records and merge those voter records into the Jury System.

Display Registered Voters
6. From the Jury Control Menu, click the Driver’s License File button to display the List Driver’s
License Master File window.
7. Select the voter record you wish to display by clicking on the desired row. To locate a particular
licensed driver, refer to Searching for Driver’s License Records below.

Jury Management System
8. Click the Display button, press F8, or select the Display option from the Process menu. You can
also right click on the row and select the Display option from the pop-up menu or double click on
the row. The Display Driver’s License File window will appear showing information for the
selected licensed driver in all completed fields.
9. To display the mailing address for the licensed driver, click the Mailing button. Click the Street
button to redisplay the street address.
10. Click the Done button to close this window and return to the List Driver’s License File window.
Searching for Driver’s License Records
6. From the Jury Control Menu, click the Driver’s License Master File button to display the List
Driver’s License Master File window.
7. Click the Search button, press F4, or select the Search option from the View menu. The Search
Driver’s License Master File window will be displayed.
8. To position the list of licensed driver’s names to a particular last name, enter the first few letters
of the name in the Full Name field. Make sure that the other search fields on this window have
been cleared.
To search for a specific licensed driver or group of licensed drivers, enter the desired search information
as described below.
Last name

All or part of the last name of the licensed driver(s) you want to find.

First Name

All or part of the first name of the licensed driver(s) you want to find.

Middle

All or part of the middle name of the licensed driver(s) you want to find.

Suffix

The suffix listed in the records of the licensed driver you wish to find.

Driver’s
License
Soc Sec #

The driver’s license number of the licensed driver you wish to find.

Home Phone

The home telephone number of the licensed driver(s) you wish to find.

Deceased

Click the down arrow to the right of this field and select the Yes option to search only licensed
driver(s) listed as deceased in the voter master file.

The social security number of the licensed driver you wish to find.

9. Click the OK button or press Enter on your keyboard to process the search. If you entered data
only in the Full Name field, the List Driver’s License Master File window will be displayed with the
name of the licensed driver matching the search data entered at the top of the list. If you
entered information in any of the other search fields, the List Driver’s License Master File window
will be redisplayed showing only voters matching the search information entered.
10. Click the Refresh button or press the F5 key to restore the List Driver’s License Master File
window to show all voters in the file.
Importing Driver’s from the DOT File
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The process for creating the Master Source Wheel in the Jury System involves the importing and merging
of records from the Driver’s License Master File provided by the Idaho Department of Transportation.
This process is outlined in the section on Building Master Source Wheel beginning on page_____.
It is highly recommended to import Voter and DOT files together.
Before the DOT file can be imported into the Jury System, it must be exported from the DOT file and
renamed DRIVER.txt on your local C:\.
Important: When importing records from the DOT file, all driver’s license records in the Jury System will
be overwritten with the current driver’s license records. Running this process will remove all driver’s
license records in the Jury System and replace them with current driver’s license records.
Working with Master Source Control Files
(Formerly known as Master Wheel)
Jury Master Source Control Files are used to identify and distinguish between different jury control
(wheel) years. These files also contain information specifying the status of each jury control year and
identifying the current control year.
Positioning the Master Source Control File List
1. From the Master Source List Control window, click the Search button or press F4. The Search Jury
Wheel Control will be displayed.
2. Enter the year you wish to find in the Wheel Year field and press Enter on your keyboard or click
the OK button. The List Jury Wheel Control window will be displayed with the year entered at the
top of the list.
3. Click the Refresh button to restore the List Jury Wheel Control window and show the most recent
jury wheel (master source) control file at the top of the list.
Adding a Master Source Control File
1. From the Master Source Control window, click the Add button, press F6, or select the Add option
from the Process menu. The Add Jury Wheel Control window will be displayed.
2. Enter the four-digit year in the Wheel year field. If this is the current jury wheel, click the Current
Wheel? check box. Note: The Active Wheel? Check box and Status field cannot be changed from
this window.
3. Click the Add button to save the information for the new jury wheel (master source) control. You
will be returned to the List Master Source Control window which will now include the jury wheel
control file just created.

Changing a Master Source Control File
1. From the Master Source Control window, select the jury wheel control file you wish to change by
clicking on the desired row.
2. Click the Change button, pressF7, or select the Change option from the Process menu.
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3. To make this the current jury wheel (master source), place a check mark in the Current Wheel?
field by clicking on the check box. Only one wheel can be marked as the current wheel at any one
time.
To inactivate the jury wheel, click the Active Wheel? check box to remove the check mark. To
replace the check mark to reactivate the wheel.
4. Click the Change button to save the information for the jury wheel control file or click the Cancel
button to close this window without saving. You will be returned to the List Master Source
Control window.
Deleting a Jury Wheel Control File
1. From the List Master Source window, select the jury wheel control file you wish to delete by
clicking on the desired row.
2. Click the Delete button or select the Delete option from the Process menu. The Delete Jury
Wheel window will be displayed with all data fields showing a red background.
3. Click the Delete button to complete the deletion of this master source control file or click the
Cancel button to close this window without deleting. You will be returned to the List Jury Master
Source Control window. Note: A master source control file cannot be deleted once jurors have
been assigned to it.
Displaying Jury Master Source Notes
1. From the Master Source List Control window, select the jury wheel control file for which you wish
to view notes by clicking on the desired row.
2. Click the Notes button or select the Notes option from the Process menu. You can also right click
on the desired control file and select the Notes option from the pop-up menu. The Edit
Additional Text for Master Source File window will be displayed. This window shows the relevant
functions that have been performed in the creation of the Master Source List.
3. Click the Done button to close this window and return to the List Master Source Control window.
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Creating a Master Source List
The first thing that needs to be determined is if the update is for a new year or an existing year. If update is for a
new year then the ‘Current Year’ field in the Jury Control File will need to be updated.
To update the year, from the Jury Control Menu, choose the
the ‘Current Year’ field to the correct year.

Jury Control File icon from the toolbar and update

After the correct year is entered, from the Jury Control Menu, choose the
the toolbar. From the List Jury Master Source Control screen click the

Jury Master Source Control icon from
Add button.
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The new Control Wheel will appear at the top of the List Jury Master Source Control screen with a status of ‘Waiting
to be Processed’.

Importing new Voter records





Voter file is exported out of the State of Idaho’s Election system.
Contact county Elections Clerk to get a current copy of the file.
Put a copy of the exported file on the C:\ drive of PC that will be processing the Jury update.
Rename the file to voter.txt.

From the Jury Control Menu, choose the
Voter Master File icon. To run the process, click the
Import Voter
from Voter System icon. New voter file names will be loaded into the system. When process is complete, click OK.
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Importing new Driver License records





Drivers License file is exported out of the State of Idaho’s Department of Transportation database.
Contact Computer Arts Service Department to get a current copy of the file.
Put a copy of the exported file on the C:\ drive of PC that will be processing the Jury update.
Rename the file to driver.txt.

From the Jury Control Menu, choose the
Drivers License File icon. To run the process, click the
Import Drivers
from Department of Transportation File button. New drivers license file names will be loaded into the system.
When process is complete, click OK.

***OPTIONAL STEP***
Mass remove records with no history from Master Source List.
Warning - this optional process should only be done in conjunction with updating the Master Source List with new
Voter / Driver information.
Process will remove all Jurors from the Master Source List that do not have any history. This includes all Jurors that
have never served on a Panel or Docket, or have not had any demographic updates made to their file.
From the Jury Control Menu, choose the
Select

Jury Master Source Control icon from the toolbar. Highlight Control

Purge Records with No History icon.

Jury Management System

Get Voter – Drivers files
Process combines new imported Voter and Driver records into one file.
From the Jury Control Menu, choose the
Year and select the

Jury Master Source Control icon from the toolbar. Highlight the Control

Get Voters - Drivers icon. When process is complete, click OK.

Scramble Names Process
Process scrambles names in newly created file and assigns a unique sequence number to each record on the Voter –
Driver file.
From the Jury Control Menu, choose the
Year and select the

Jury Master Source Control icon from the toolbar. Highlight the Control

Scramble Names icon. When process is complete, click OK.
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Remove Duplicates
Process compares all names on the Voter – Driver file and system removes any duplicates based on specific criteria
that determine if the record is a duplicate.
From the Jury Control Menu, choose the
Year and select the

Jury Master Source Control icon from the toolbar. Highlight the Control

Remove Duplicates icon.

Select all of the options with a checkmark and click Process button.

Manually Remove Duplicates
Process allows user to print a report and find any remaining duplicates that the system did not remove and remove
them manually.
From the Jury Control Menu, choose the
Year and select the

Jury Master Source Control icon from the toolbar. Highlight the Control

Print Reports icon.

Select and print the Jury Master Source List (JY301) report. On the report filter select the following options.
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Look at each person on the report and it will tell you which file the name came in from (Voter or Driver) and
demographic information. If a duplicate is found on the report, mark the person and the name will need to be
removed manually from the Manually Remove Duplicates screen.

To manually remove duplicate names that are found on the Jury Master Source List report, from the Jury Control
Menu, choose the

Jury Master Source Control icon from the toolbar. Highlight the Control Year and select the

Manually Remove Duplicates icon.

Manually remove the duplicate record by highlighting the Driver or Voter record with the least amount of
information and click the Manually Remove Duplicates button. Change Duplicate Status to Removed Manually.
Multiple records can be removed at one time by highlighting multiple records and clicking the Mass Remove button.
Note: Names highlighted in yellow were automatically removed by the system and cannot be removed again.

Jury Management System

Compare Voter file records against current Master Source List records
Process takes all remaining Voter file names and compares them with the information that is currently in the Master
Source List. If the system does not find any changes, it will leave what is currently in the Master Source list alone. If
the system does find a change in demographic information, it will mark the record so that it can be manually
compared with what is currently in the Master Source List.
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From the Jury Control Menu, choose the
Year and select the

Jury Master Source Control icon from the toolbar. Highlight the Control

Process Voters -vs- Master Source List icon. When process is complete, click OK.

Compare Driver file records against current Master Source List records
Process takes all remaining Driver file names and compares them with the information that is currently in the
Master Source List. If the system does not find any changes, it will leave what is currently in the Master Source list
alone. If the system does find a change in demographic information, it will mark the record so that it can be
manually compared with what is currently in the Master Source List.
From the Jury Control Menu, choose the
Year and select the

Jury Master Source Control icon from the toolbar. Highlight the Control

Process Drivers -vs- Master Source List icon. When process is complete, click OK.

Manually compare Voter / Driver records with changes against current Master Source List records
Process of manually comparing records from the new Voter / Driver files that have different demographic
information than the current Master Source List record. All accepted records will overwrite existing information in
the current Master Source List. All overwritten demographic information can be found in Jurors History or Juror
Name / Address History on the Master Source List screen.
From the Jury Control Menu, choose the
Year and select the

Jury Master Source Control icon from the toolbar. Highlight the Control

Process Records with Changes against Master Source List icon.

The following screen lists any Voter / Driver records that have changes vs. the current Master Source List records.
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By highlighting each record and clicking on the
Display Eligibility Record -vs- Master Source, all differances on the
Voter or Driver file will show in yellow vs. what is currently in the Master Source List. Each record needs to be
looked at and either Accepted or Rejected.
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If record is Accepted, system will automatically update the Master Source List with the new information.
If record is Rejected, system rejects the record and set the records status to ‘Rejected in Comparison’.

Update Master Source List with new Voter / Driver information
This is the last step in the update process which takes the final verified Voter or Driver file, and imports the new
information into the Master Source List. All new names that do not currently exist in the Master Source List will be
added and the system will track the date that the latest information was updated.
From the Jury Control Menu, choose the
Year and select the
OK.

Jury Master Source Control icon from the toolbar. Highlight the Control

Update Master Source List with New Imported Records icon. When process is complete, click
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Congratulations! Process is complete. Master Source List is now updated.
Assigning Jurors to a Panel
1.

From the Jury Control Menu, click the
Assign Jurors to a Panel toolbar button or from Select,
click Assign Jurors to a Panel. The Add Panel Control will be displayed.

2.

Enter all applicable information for create the juror pane. Descriptions for each data field are
provided below.

Services
Dates

Enter the From and To dates to indicate the date range for which this jury panel will be in
service.

Desired # of
Jurors

Enter the number of jurors you would like to include in this panel. This number can be no
more than the number shown in the Available Jurors field.

Date Drawn

Enter the date on which the jury panel was drawn. This will default to the current date but
can be changed if necessary.

Date Mailed

Enter the date on which qualification notices were mailed to jurors on this panel. If a date is
entered here, the date will be shown on the individual records of all jurors on the panel.

3.

4.

Click the Add button to save information for this jury panel and to create the panel with the
number of jurors selected. The system will randomly select jurors and assign them to a new
panel. When this process is complete, a message will be displayed telling you that the jurors
were successfully assigned to the panel.
Click the OK button on the message window to return to the Jury Control Menu.
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Working with the Eligibility Wheel
To display the eligibility wheel for the current year, click the
View Eligibility Wheel button on the
Jury Control Menu toolbar. This will display the List Eligibility Wheel window showing all records in the
Eligibility Wheel for the current jury year.

If you want to view the eligibility wheel for a different year, click the
Select Different Year
button to display the List Jury Wheel Control window. From this window, click on the desired year and
then click the Select button or double click on the year. The List Eligibility Wheel window will redisplayed
showing the eligibility wheel records for the selected year.

Displaying an Eligible Record
1. From the List Eligibility Wheel window, select the juror records to be displayed by clicking on the
desired row.
2. Click the
Display button, press F8, or select the Display option from the Process menu. You
can also right click on the row and select the Display option from the pop up menu or double click
on the row. The Display Eligibility Wheel window will appear showing detailed information
pertaining to the selected juror.
3. To view the mailing address for the juror, click the Mailing button. Click the Street button to
redisplay the street address.
4. Click the Done button when finished to close this window and return to the List Eligibility window.
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Searching the Eligibility Wheel
1. From the List Eligibility Wheel window, click the
Search button, press F4, or select the Search
option from the View menu. The Search Eligibility Wheel window will be displayed.

2. Enter the information to be used for the search. Descriptions for each data field are shown
below.

Last Name

The first few letters of the last name of the juror you are looking for. This field is used to
position the list of jurors to a particular name.

First Name

All or part of the first name of the juror(s) you wish to find.

Middle

All or part of the middle names of the juror(s) you wish to find.

Suffix

The suffix listed in the juror records you want to find (i.e., “JR”, “III”, etc.).

Address1/Address2

All or part of the first or second address lines of the juror(s) you wish to find. The field label
will appear in blue if the street address is being displayed or in red if the mailing address is
being displayed.

City/State/Zip

All or part of the city, state, or zip code of the juror(s) you wish to find. The state should be
entered using the two-character postal abbreviation. Again, blue indicates street address;
red indicates mailing address.

Soc Sec #

The social security number of the juror you want to find.

Birthdate

The date of birth of the juror(s) you want to find.

Home Phone

The home telephone number of the juror(s) you want to find.

Driver’s License

The driver’s license number of the juror you want to find.
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Duplicate
Deceased

ELG Status

The duplicate status of the juror(s) you are looking for. To select a particular duplicate
status, click the down arrow to the right of this field and then click on the desired status.
The deceased status of the juror(s) you want to find. To find only deceased jurors, click on
the down arrow next to the field and select the Yes code.
The eligibility status of the juror(s) you want to find. To display only voter-type records in
the eligibility wheel, click on the arrow next to this field and select the Voter option. Select
the Driver option to display only driver’s license records.

3. Click the OK button to process the search and return to the List Eligibility Wheel window. If you
entered data in the Last Name field, the list of juror names will be positioned to the first name in
the list beginning with the letters entered. Otherwise, the list will only include jurors matching
the search entered.
4. Click the
Refresh button or press F5 to reset the eligibility wheel list to include all jurors in
alphabetical order.
Working with Juror Exemption Codes
Listing Exemption Codes
To display a list of exemption codes, click the
Exemption Codes button from the toolbar on the
Jury Control Menu. The List Juror Exemption Codes window will display showing all valid exemption
codes entered into the system.

Adding an Exemption Code
1. From the Jury Control Menu, click the
Exemption Codes button or select the Exemption
Codes option from the Select menu. The List Juror Exemption Codes window will be displayed.
2. Click the

Add button, press F6, or select the Add option from the Process menu.
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3.
4. Enter a two-character code identifying the new exemption code in the Exemption field and a
description (up to 25 characters in length) for the code in the Description field.
5. Click the Add button to save the new exemption code. Upon clicking the Add button, a User
Information section will appear on the window showing the exemption code just previously
entered.
6. After adding all desired exemption codes, click the Cancel button to close the window and return
to the List Exemption Codes window. Notice that the Exemption Code(s) just added will now
appear on the List Juror Exemption Codes screen at the bottom of the grid.
Changing an Exemption Code
1.

From the Jury Control Menu, click the
Exemption Codes button or select the
Exemption Codes option from the Select menu. The List Juror Exemption Codes window
will display.

2.

Click the
Change button, press F7, or select the Change option from the Process
menu. The Change Juror Exemption Codes window will display.

3.

Change the description of the exemption code as necessary.

4.

Click the Change button to save the new description and return to the List Juror
Exemption Codes window.

Deleting an Exemption Code
1.

2.
3.

4.

From the Jury Control Menu, click the
Exemption Codes button or select the
Exemption Codes option from the Select menu. The List Juror Exemption Codes window
will display.
Select the exemption code to be deleted by clicking on the row.
Click the
Delete button or select the Delete option from the Process menu. You can
also right click on the row and select Delete from the pop up menu. The Delete Juror
Exemption Codes window will display with all data fields showing a red background.
Click the Delete button to complete the removal of the exemption code or click the
Cancel button to close this window without deleting the code. You will be returned to
the List Juror Exemption Codes window.
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Copying an Exemption Code
1. From the Jury Control Menu, click the
Exemption Codes button or select the Exemption
Codes option from the Select menu. The List Juror Exemption Codes window will display.
2. Highlight the exemption code you desire to copy and click the
Copy button, or select the
Copy option from the Process menu. The Add Juror Exemption Codes window will be displayed
with the information from the just previously highlighted code showing in all completed fields.
3. Make changes as necessary.
4. Click the
Add button to add the new code and return to the List Juror Exemption Codes
window. Notice that both the original and the newly created codes are now shown within the
grid on this screen.
Searching Exemption Codes
1. From the Jury Control Menu, click the
Exemption Codes button or select the Exemption
Codes option from the Select menu. The List Juror Exemption Codes window will display.
2. Click the
Search button, press F4, or select the Search option from the View menu. The
Search Juror Exemption Codes window will display.

3. To position the list of exemption codes, enter the first character of the desired code in the
Exemption Code field. To find an exemption code by description, enter all or part of the
description in the Description field.
4. Click the OK button to process the search and return to the List Juror Exemption Codes window.
If you entered data in the Description field, this window will display only exemption codes with
description containing the search data entered. If you entered data in the Exemption Code field,
the first exemption code matching the data entered will be displayed at the top of the list.
5. Click the
codes.

Refresh button or press F5 to restore the exemption code list to show all exemption
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Working with Jury Payment Codes
Listing Jury Payment Codes
To display a list of jury payment codes, click the
Juror Payment Types button from the toolbar
on the Jury Control Menu. The List Jury Payment Type window will be displayed showing all valid
payment types entered in the system.

Adding a Jury Payment Code
1. From the Jury Control Menu, click the
Juror Payment Types button or choose the
Juror Payment Types form the Select menu. The List Jury Payment Type window will be
displayed.
2. Click the
Add button, press F6, or select the Add option from the Process menu.
The Add Jury Payment Type window will be displayed.

3. Enter a code, up to six characters in length that will identify the new payment type in the
Payment Type Code field. Enter a description, up to 25 characters in length, for the
payment type in the Payment Type Description field. In the Fund, Dept., Account and Sub
fields, enter the financial account from which your payments will be made.
4. Click the Add button or press Enter to save the new payment type code. A User
Information section will be displayed on the window showing the new code just entered.
You can continue entering payment type codes, if necessary.
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5. After entering all desired codes, click the Cancel button or press the ESC key to close the
window. The new code(s) entered will now display, in alphabetical order within the grid
on the screen.
Changing a Jury Payment Code
1. From the Jury Control Menu, click the
Juror Payment Types button or choose the
Juror Payment Types form the Select menu. The List Jury Payment Type window will be
displayed.
2. Select the payment type code to be changed by clicking on the appropriate row.
3. Click the
Change button, press F7, or select the Change option form the Process
menu. You can also right click on the row and select the Change option from the drop
down menu or double click on the row. The Change Jury Payment Type window will
display.
4. Change the description and financial account number information as necessary.
5. Click the Change button to save any modifications made or click the Cancel button to
close this window without saving changes. You will be returned to the List Jury Payment
Type window.
Deleting a Jury Payment Code
1. From the Jury Control Menu, click the
Juror Payment Types button or select the
Juror Payment Types option from the Select menu. The Juror Payment Types window will
display.
2. Select the juror payment type to be deleted by clicking on the row.
3. Click the
Delete button or select the Delete option from the Process menu. You can
also right click on the row and select Delete from the pop up menu. The Delete Juror
Payment Types window will display with all data fields showing a red background.
4. Click the Delete button to complete the removal of the juror payment type or click the
Cancel button to close this window without deleting the code. You will be returned to
the Juror Payment Types window.
Copying a Jury Payment Code

1. From the Jury Control Menu, click the
Juror Payment Types button or select the Juror
Payment Types option from the Select menu. The Juror Payment Types window will display.
2. Highlight the exemption code you desire to copy and click the
Copy button, or select the
Copy option from the Process menu. The Add Juror Payment Types window will be displayed
with the information from the just previously highlighted code showing in all completed fields.
3. Make changes as necessary.
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4. Click the
Add button to add the new payment type and return to the Juror Payment Types
window. Notice that both the original and the newly created codes are now shown within the
grid on this screen in alphabetical order.

Searching Juror Payment Codes
1. From the Jury Control Menu, click the
Juror Payment Codes button or select the Juror
Payment Codes option from the Select menu. The Juror Payment Codes window will display.
2. Click the
Search button, press F4, or select the Search option from the View menu. The
Search Juror Exemption Codes window will display.

3. To position the list of payment types, enter the first character of the desired code in the Payment
Type Code field. To find payment type code by description, enter all or part of the description in
the Payment Type Description field.
4. Click the OK button to process the search and return to the Juror Payment Codes window. If you
entered data in the Payment Type Code field, this window will display only payment codes with
description containing the search data entered. If you entered data in the Payment Type
Description field, the first payment type matching the data entered will be displayed at the top of
the list.
5. Click the
types.

Refresh button or press F5 to restore the payment type list to show all payment

Working with Court Locations
Listing Court Locations
To display a list of court locations, click the
Court Locations button or select the Court Locations
option from the Select menu on the Jury Control Menu. The List Court Locations window will be
displayed showing all court locations entered in the system
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Adding a Court Location
1. From the Jury Control Menu, click the
Court Locations button or select the Court Locations
option from the Select menu on the Jury Control Menu. The List Court Locations window will be
displayed showing all court locations entered in the system.
2. Click the
Add button, press F6, or select the Add option from the Process menu. The Add
Court Locations window will display.

3. Enter the applicable information for this court location. Descriptions for each data field are
shown below.

Court Location

(required) The alphanumeric code, up to ten characters in length that will be used to
identify this court location. Court locations are used on dockets to specify where a trial is
going to take place.

Description

(required) A description for this court location. Enter the full name of the court location,
up to 30 characters in length, as you want it to appear on documents for public distribution.

Address1/Address2

The street address for this court location (The Address1 field is required).
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City/State/Zip

The city, state, and zip code for this court location (required). The state should be entered
using the two-character postal abbreviation.

Court Phone

The telephone number for this court location (required).

4. Click the Add button or press Enter to save the new court location information. A User
Information section will be displayed on the window showing the new location just entered. You
can continue entering court locations, if necessary.
5. When you have entered all desired locations, click the Cancel button or press the ESC key to close
this window and return to the List Court Locations window. Notice that the newly added court
location(s) will now display in alphabetical order within the grid on the List Court Locations
window.
Changing a Court Location
1. From the Jury Control Menu, click the
Court Locations button or select the Court Locations
option from the Select menu. The List Court Locations window will be displayed.
2. Select the court location to be changed by clicking on the desired row.
3. Click the
Change button, press F7, or select the Change option from the Process menu. You
can also right click on the row and select the Change option from the drop down menu or double
click on the row. The Change Court Locations window will be displayed.
4. Change the information for this court location as necessary. A description of each data field is
listed in the Adding a Court Location section, above.
5. Click the Change button to save any modifications or click the Cancel button to close this window
without saving any changes. You will be returned to the List Court Locations window.
Deleting a Court Location
1. From the Jury Control Menu, click the
Court Locations button or select the Court Locations
option from the Select menu. The List Court Locations window will display.
2. Select the court location to be deleted on the desired row.
3. Click the
Delete button or select the Delete option from the Process menu. You can also
right click on the row and select the Delete option from the drop down menu. The Delete Court
Locations window will display.
4. Click the Delete button to complete the removal of the court location or click the Cancel button
to close this window without deleting. You will be returned to the List Court Locations window.
Copying a Court Location
1. From the Jury Control Menu, click the
Court Locations button or select the Court Locations
option from the Select menu. The Court Locations window will display.
2. Highlight the court location you desire to copy and click the
Copy button, or select the Copy
option from the Process menu. The Add Court Locations window will be displayed with the
information from the just previously highlighted location showing in all completed fields.
3. Make changes as necessary.
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4. Click the
Add button to add the new court location and return to Court Locations window.
Notice that both the original and the newly created location are now shown within the grid on
this screen in alphabetical order.
Searching Court Locations
1. From the Jury Control Menu, click the Court Locations button or select the Court Locations option
from the Select menu. The List court Locations window will be displayed.
2. Click the Search button, press F4, or select the Search option from the View menu. The Search
Court Locations window will be displayed.

3. To position the list of court lcoations, enter the first character or characters of the location code
in the Court Location field. To search for a particular court location, enter all or part of the
description for the desired location in the Description field or enter the telephone numer of the
location.
4. Click the OK button or press Enter to process the search and return to the List Court Locations
window. If you entered data in the Court Location field, the first location matching the data
entered will be displayed at the top of the list. If you enetered information in the Description or
Court Phone fields, only court locations containing the search data entered will be shown.
5. Click the Refresh button or press F5 to restore the court locations to show all locations.
Working with Judge Records
Listing Judge Records
To display a list of judge records, click the
Judges button or choose the Judges option from the Select
menu on the Jury Control Menu. The List Judge window will be displayed showing all judge records
entered in the system.

Jury Management System

Adding a Judge Record
1. From the Jury Control Menu, click the Judges button or choose the Judges option from the Select
menu. The List Judges window will be displayed.
2. Click the Add button, press F6 or select the Add option from the Process menu. The Add Judge
window will be displayed.

3. Enter the name of the judge to be added to the system. You can include the title
“Judge” in the name, if desired.
4. Click the Add button to save the new judge record. A user information section will now display
on the screen showing the judge just previously entered. Continue adding judges. When
finished, click the Cancel button or press ESC to return to the List Judge window. Notice that the
newly added judges will now display in alphabetical order within the grid on this screen.
Changing a Judge Record
1. From the Jury Control Menu, click the Judges button or select the Judges option from the Select
menu. The List Judges window will be displayed.
2. Select the judge record to be changed by clicking on the desired row.
3. Click the Change button, press F7 or select the Change option from the Process menu. You can
also right click on the row and select the Change option from the drop down menu or just double
click on the row. The Change Judge window will be displayed.
4. Change the name listed on this judge record as necessary.
5. Click the Change button to save the modifications to this record or click the Cancel button to
close this window without saving. You will be returned to the List Judge window.
Deleting a Judge Record
1. From the Jury Control Menu, click the Judges button or choose the Judges option from the Select
menu. The List Judges window will be displayed.
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2. Select the judge record to be deleted by clicking on the desired row.
3. Click the Delete button or select the Delete option from the Process menu. You can also right
click on the row and select the Delete option from the drop down menu. The Delete Judge
window will be displayed with all data fields showing a red background.
4. Click the Delete button to complete the deletion of this judge record or click Cancel to close this
window without deleting. You will be returned to the List Judge window.
Copying a Judge Record
1. From the Jury control Menu, click the Judges button or choose the Judges option from the Select
menu. The List Judge window will be displayed.
2. Highlight the judge record that you desire to copy and click the Copy button, or select the Copy
option from the Process menu. You can also right click on the row and select the Copy option
from the drop down menu. The Add Judge window will be displayed with the information from
the just previously highlighted judge record showing in all completed fields.
3. Make changes as necessary and click the Copy button to add the new judge record and return to
the List Judge window. Notice that the just previously highlighted judge record as well as the
newly created judge record will now show within the grid on this screen in alphabetical order.
Searching Judge Records
1. From the Jury Control Menu, click the Judges button or choose the Judges option from the Select
menu. The List Judges window will be displayed.
2. Click the Search button, press F4 or select the Search option from the View menu. The Search
Judge window will be displayed.
3. To position the list judges to a particular name, enter the first few letters of the desired name in
the Judge field. To find a specific judge, enter the judge’s ID number in the Judge # field.
4. Click the OK button or press Enter to process the search and return to the List Judge window. If
you entered text in the Judge field, the first judge’s record matching the data entered will be
shown at the top of the list. If you entered a judge number, only that record will be listed.
5. Click the Refresh button or press F5 to restore the judges list to show all judge records.
Working with the Jury Control File
The Jury Control file is used to store information and setting used throughout the Jury System. Important:
Because control file information affects many aspects of the Jury System, changes should only be made
by qualified personnel. Contact Computer Arts, Inc. prior to making changes to the control file data.
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Changing the Jury Control File
1. From the Jury Control File Menu, click the
Jury Control File toolbar button. The Change Jury
Control File window will be displayed.
2. Enter or change jury control file information as necessary. See descriptions for each data field
below.

County

The name of the county. Do not include the word “County” in this field. The
county name is used on system reports.

Judicial District #

The number (without preceding zeros) of the judicial district in which your county is
located. For example, if you are in the First Judicial District, enter 1, and if you are
in the Second Judicial District, enter 2. The Judicial District is used on system
reports.

Clerk

The name of the County Clerk. County Clerk’s name is used on system reports for
public distribution. Enter the name in first/middle/last order (for example, Joanne
S. Anderson).

Address1

The first line of the street address of the Clerk’s office for the county.
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Address2

The second line of the street address of the Clerk’s office for the county, if
applicable.

City/State/Zip

The city, state, and zip code for the Clerk’s office. Enter the state using the twocharacter postal abbreviation.

Business Phone

The business phone number of the Clerk’s office. This number will be printed on
documents used for public distribution.

Business Hours

The opening and closing times for the Clerk’s office. These times should be entered
using hh:mm:ss format (for example, 09:00:00 for 9:00).

Fax

The business fax number of the Clerk’s office. This number will be printed on
documents used for public distribution.

County Web Address

The web site address for the county web site. This web address may be printed on
documents used for public distribution.

On Close Panel-Set
Available Date 2 yrs from
Last Date of Service?

This should be checked if jurors needs to be placed on a panel 2 years from their
last date of service.

Use Scramble Field on
Pulling Dockets to Replace
Drawing of Hopper Tags?

After jurors are created in a docket and if this is checked, the system generates a
random set of numbers and uses that to randomly set the jurors seating/selected
number. When they draw hopper tags, they put the jurors names in a hopper and
pull one at a time out and that is the jurors seating/selected number.

Default Panel/Docket
Jurors to Sort by Name?

If this is not checked, the Panel/Docket juror names will be listed by reporting
number.

Set Initial Focus to
Exemption Code on Master
Source change?

When you open up the Change Master Source List and this is selected then the
cursor is set to the Exemption Code field.

Automatically Copy Mailing
Address to Street Address
on Add/Change?

If a juror mailing address is changed on the Master Source, the system will
automatically copy the mailing address to Street Address if this is checked.

Mileage Rage

The amount per mile to jurors for mileage reimbursement. This amount should be
entered in terms of dollars (for example, 31 cents is entered as .0310).

Base Distance

The base distance in miles used to calculate half day jury service fees. You can
specify different half day rates for jurors who live within the base distance and
jurors who live outside the base distance.

Half Date Rate within Base
Distance

Enter the half-day payment rate for jurors living within the Base Distance entered
above.

Half Date Rate outside
Base Distance

Enter the half-day payment rate for jurors living outside the Base Distance entered
above.

Full Day Rate

The full day payment rate for all jurors.
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Use Texting Option?

This option will be inactive if your county has elected to use the jury text/email
notification feature.

Do you use Mailer Forms?

If you use mailer forms, check this box.

Use Auto Signature

Check this box to use a signature font where a county clerk or Jury Commissioner
signature is used on public documentation.

Disregard Home Phone in
Comparison Check

From the List Jury Master Source Control when they run these options below and
these are checked, then when it does the Comparison check from the new
imported Voters/Drivers to what is on the Master Source List then it will disregard
these options.

Disregard Work Phone in
Comparison Check

From the List Jury Master Source Control when they run these options below and
these are checked, then when it does the Comparison check from the new
imported Voters/Drivers to what is on the Master Source List then it will disregard
these options.

Disregard Cell Phone in
Comparison Check

From the List Jury Master Source Control when they run these options below and
these are checked, then when it does the Comparison check from the new
imported Voters/Drivers to what is on the Master Source List then it will disregard
these options.

Disregard Email Phone in
Comparison Check

From the List Jury Master Source Control when they run these options below and
these are checked, then when it does the Comparison check from the new
imported Voters/Drivers to what is on the Master Source List then it will disregard
these options.

Hide Active Panel Jurors
Button

From the List Jury Master Source Control when they run these options below and
these are checked, then when it does the Comparison check from the new
imported Voters/Drivers to what is on the Master Source List then it will disregard
these options.

3. Click the Change button to save any modifications made to the control file information or click
the Cancel button to close this window without saving your changes. You will be returned to the
Jury Control Menu.
Changing Jury Commissioner Information
1. From the Jury Control Menu, click the Jury control File toolbar button. The Change Jury Control
File window will be displayed.
2. Click the Jury/Deputy Commissioner Information button located at the lower right of the control
file window.
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3. Enter the names and business addresses for both the Jury Commissioner and Deputy
Commissioner in the appropriate fields. Since the names entered here are used on reports for
public distribution, you should enter the names as you wish them to appear on these reports.
4. Click the Change button to save any modification made to the Jury Commissioner information or
click the Cancel button to Close this window without saving your changes. You will be returned to
the Jury Control Menu.
Maintaining Reports
The
Maintain Reports button on the Change Jury Control File window provides for the setup and
definition of reports used throughout the Jury System. Clicking this button will display a list of reports
available in the system and allows for the addition and modification of reports.
CAUTION!!!
Instruction for changing reports are not included in this manual. These modifications should only be
made by Computer Arts personnel.

CHAPTER EIGHT
Frequently Asked Questions
A list of frequently asked questions pertaining to the Jury Management System has been compiled and is
included below for your easy reference.

CHAPTER NINE
Technical Support
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